
Simple Formulas 

One of the most powerful features in Excel is the ability to calculate numerical information using formulas. 

Just like a calculator, Excel can add, subtract, multiply, and divide. In this lesson, we'll show you how to 

use cell references to create simple formulas. 

Practice document: Excel2013_SimpleFormulas_Practice.xlsx 

Mathematical operators 

Excel uses standard operators for formulas, such as a plus sign for addition (+), a minus sign for subtraction (-

), an asterisk for multiplication (*), a forward slash for division (/), and a caret (^) for exponents. 

 

All formulas in Excel must begin with an equals sign (=). This is because the cell contains, or is equal to, the 

formula and the value it calculates. 

Understanding cell references 

While you can create simple formulas in Excel manually (for example, =2+2 or =5*5), most of the time you will 

use cell addresses to create a formula. This is known as making a cell reference. Using cell references will 

ensure that your formulas are always accurate because you can change the value of referenced cells without 

having to rewrite the formula. 



 

By combining a mathematical operator with cell references, you can create a variety of simple formulas in 

Excel. Formulas can also include a combination of cell references and numbers, as in the examples below: 

 

To create a formula: 

In our example below, we'll use a simple formula and cell references to calculate a budget. 

1. Select the cell that will contain the formula. In our example, we'll select cell B3. 



 

2. Type the equals sign (=). Notice how it appears in both the cell and the formula bar. 

 

3. Type the cell address of the cell you want to reference first in the formula: cell B1 in our 
example. A blue border will appear around the referenced cell. 

 

4. Type the mathematical operator you want to use. In our example, we'll type the addition 
sign (+). 

5. Type the cell address of the cell you want to reference second in the formula: cell B2 in our 
example. A red border will appear around the referenced cell. 

 

6. Press Enter on your keyboard. The formula will be calculated, and the value will be displayed 
in the cell. 



 

If the result of a formula is too large to be displayed in a cell, it may appear as pound signs (#######) instead 

of a value. This means the column is not wide enough to display the cell content. Simply increase the column 

width to show the cell content. 

Modifying values with cell references 

The true advantage of cell references is that they allow you to update data in your worksheet without having 

to rewrite formulas. In the example below, we've modified the value of cell B1 from $1,200 to $1,800. The 

formula in B3 will automatically recalculate and display the new value in cell B3. 

 

To create a formula using the point-and-click method: 

Rather than typing cell addresses manually, you can point and click on the cells you want to include in your 

formula. This method can save a lot of time and effort when creating formulas. In our example below, we'll 

create a formula to calculate the cost of ordering several boxes of plastic silverware. 

1. Select the cell that will contain the formula. In our example, we'll select cell D3. 



 

2. Type the equals sign (=). 

3. Select the cell you want to reference first in the formula: cell B3 in our example. The cell 
address will appear in the formula, and a dashed blue line will appear around the referenced 
cell. 

 

4. Type the mathematical operator you want to use. In our example, we'll type the multiplication 
sign (*). 

5. Select the cell you want to reference second in the formula: cell C3 in our example. The cell 
address will appear in the formula, and a dashed red line will appear around the referenced 
cell. 

 

6. Press Enter on your keyboard. The formula will be calculated, and the value will be displayed 
in the cell. 



 

Formulas can also be copied to adjacent cells with the fill handle, which can save a lot of time and effort if you 

need to perform the same calculation multiple times in a worksheet. Review our lesson on Relative and 

Absolute Cell References to learn more. 

 

 

To edit a formula: 

Sometimes you may want to modify an existing formula. In the example below, we've entered an incorrect 

cell address in our formula, so we'll need to correct it. 

1. Select the cell containing the formula you want to edit. In our example, we'll select cell B3. 



 

2. Click the formula bar to edit the formula. You can also double-click the cell to view and edit 
the formula directly within the cell. 

 

3. A border will appear around any referenced cells. In our example, we'll change the second part 
of the formula to reference cell B2 instead of cell C2. 

 

4. When you're finished, press Enter on your keyboard or click the checkmark in the formula bar. 

 

5. The formula will be updated, and the new value will be displayed in the cell. 

 

If you change your mind, you can press the Esc key on your keyboard to avoid accidentally making changes to 

your formula. 



To show all of the formulas in a spreadsheet, you can hold the Ctrl key and press ` (grave accent). The grave 

accent key is usually located in the top-left corner of the keyboard. You can press Ctrl+` again to switch back 

to the normal view. 

Challenge! 

1. Open the practice document Excel2013_SimpleFormulas_Practice.xlsx. 

2. Create a simple addition formula using cell references. Create the formula in cell B4 to 
calculate the total budget. 

3. Try modifying the value of a cell referenced in a formula. Change the value of cell B2 to 
$2,000. Notice how the formula in cell B4 recalculates the total. 

4. Try using the point-and-click method to create a formula. Create a formula in cell G5 that 
multiplies the cost of napkins by the quantity needed to calculate the total cost. 

5. Edit a formula using the formula bar. Edit the formula in cell B9 to change the division 
sign (/) to a minus sign (-). 

Complex formulas 

A simple formula is a mathematical expression with one operator, such as 7+9. A complex formula has more 

than one mathematical operator, such as 5+2*8. When there is more than one operation in a formula, 

the order of operations tells Excel which operation to calculate first. In order to use Excel to calculate complex 

formulas, you will need to understand the order of operations 

Practice document: Excel2013_ComplexFormulas_Practice.xlsx 

The order of operations 

Excel calculates formulas based on the following order of operations: 

1. Operations enclosed in parentheses 

2. Exponential calculations (3^2, for example) 

3. Multiplication and division, whichever comes first 

4. Addition and subtraction, whichever comes first 

Creating complex formulas 

In the example below, we will demonstrate how Excel solves a complex formula using the order of operations. 

Here, we want to calculate the cost of sales tax for a catering invoice. To do this, we'll write our formula 

as =(D2+D3)*0.075 in cell D4. This formula will add the prices of our items together and then multiply that 

value by the 7.5% tax rate (which is written as 0.075) to calculate the cost of sales tax. 



 

Excel follows the order of operations and first adds the values inside the parentheses: (44.85+39.90) = $84.75. 

It then multiplies that value by the tax rate: $84.75*0.075. The result will show that the sales tax is $6.36. 

 

It is especially important to enter complex formulas with the correct order of operations. Otherwise, Excel will 

not calculate the results accurately. In our example, if the parentheses are not included, the multiplication is 

calculated first and the result is incorrect. Parentheses are the best way to define which calculations will be 

performed first in Excel. 

 

To create a complex formula using the order of operations: 

In our example below, we will use cell references along with numerical values to create a complex formula 

that will calculate the total cost for a catering invoice. The formula will calculate the cost for each menu item 

and then add those values together. 

1. Select the cell that will contain the formula. In our example, we'll select cell C4. 



 

2. Enter your formula. In our example, we'll type =B2*C2+B3*C3. This formula will follow the 
order of operations, first performing the multiplication: 2.29*20 = 45.80 and 3.49*35 = 122.15. 
It then will add those values together to calculate the total: 45.80+122.15. 

 

3. Double-check your formula for accuracy, then press Enter on your keyboard. The formula 
will calculate and display the result. In our example, the result shows that the total cost for the 
order is $167.95. 

 

You can add parentheses to any equation to make it easier to read. While it won't change the result of the 

formula in this example, we could enclose the multiplication operations within parentheses to clarify that they 

will be calculated before the addition. 

 

Challenge! 

1. Open the practice document Excel2013_ComplexFormulas_Practice.xlsx. 

2. Create a complex formula that will perform addition before multiplication. Create a formula 
in cell D6 that first adds the values of cells D3, D4, and D5 and then multiplies their total 
by 0.075. Hint: You'll need to think about the order of operations for this to work correctly. 



Relative and Absolute Cell References 

There are two types of cell references: relative and absolute. Relative and absolute references behave 

differently when copied and filled to other cells. Relative references change when a formula is copied to 

another cell. Absolute references, on the other hand, remain constant, no matter where they are copied. 

Practice document: Excel2013_References_Practice.xlsx 

Relative references 

By default, all cell references are relative references. When copied across multiple cells, they change based on 

the relative position of rows and columns. For example, if you copy the formula =A1+B1 from row 1 to row 2, 

the formula will become =A2+B2. Relative references are especially convenient whenever you need 

to repeat the same calculation across multiple rows or columns. 

To create and copy a formula using relative references: 

In the following example, we want to create a formula that will multiply each item's price by the quantity. 

Instead of creating a new formula for each row, we can create a single formula in cell D2 and then copy it to 

the other rows. We'll use relative references so the formula correctly calculates the total for each item. 

1. Select the cell that will contain the formula. In our example, we'll select cell D2. 

 

2. Enter the formula to calculate the desired value. In our example, we'll type =B2*C2. 



 

3. Press Enter on your keyboard. The formula will be calculated, and the result will be displayed 
in the cell. 

4. Locate the fill handle in the bottom-right corner of the desired cell. In our example, we'll locate 
the fill handle for cell D2. 

 

5. Click, hold, and drag the fill handle over the cells you want to fill. In our example, we'll select 
cells D3:D12. 



 

6. Release the mouse. The formula will be copied to the selected cells with relative references, 
and the values will be calculated in each cell. 

 

You can double-click the filled cells to check their formulas for accuracy. The relative cell references should be 

different for each cell, depending on their rows. 



 

Absolute references 

There may be times when you do not want a cell reference to change when filling cells. Unlike relative 

references, absolute references do not change when copied or filled. You can use an absolute reference to 

keep a row and/or column constant. 

An absolute reference is designated in a formula by the addition of a dollar sign ($). It can precede the column 

reference, the row reference, or both. 

 

You will generally use the $A$2 format when creating formulas that contain absolute references. The other 

two formats are used much less frequently. 

When writing a formula, you can press the F4 key on your keyboard to switch between relative and absolute 

cell references, as shown in the video below. This is an easy way to quickly insert an absolute reference. 

To create and copy a formula using absolute references: 

In our example, we'll use the 7.5% sales tax rate in cell E1 to calculate the sales tax for all items in column D. 

We'll need to use the absolute cell reference $E$1 in our formula. Because each formula is using the same tax 



rate, we want that reference to remain constant when the formula is copied and filled to other cells in column 

D. 

1. Select the cell that will contain the formula. In our example, we'll select cell D3. 

 

2. Enter the formula to calculate the desired value. In our example, we'll type =(B3*C3)*$E$1. 

 

3. Press Enter on your keyboard. The formula will calculate, and the result will display in the cell. 

4. Locate the fill handle in the bottom-right corner of the desired cell. In our example, we'll locate 
the fill handle for cell D3. 



 

5. Click, hold, and drag the fill handle over the cells you want to fill: cells D4:D13 in our example. 

 

6. Release the mouse. The formula will be copied to the selected cells with 
an absolute reference, and the values will be calculated in each cell. 



 

You can double-click the filled cells to check their formulas for accuracy. The absolute reference should be the 

same for each cell, while the other references are relative to the cell's row. 

 

Be sure to include the dollar sign ($) whenever you're making an absolute reference across multiple cells. The 

dollar signs were omitted in the example below. This caused Excel to interpret it as a relative reference, 

producing an incorrect result when copied to other cells. 



 

Using cell references with multiple 
worksheets 

Excel allows you to refer to any cell on any worksheet, which can be especially helpful if you want to 

reference a specific value from one worksheet to another. To do this, you'll simply need to begin the cell 

reference with the worksheet name followed by an exclamation point (!). For example, if you wanted to 

reference cell A1 on Sheet1, its cell reference would be Sheet1!A1. 

Note that if a worksheet name contains a space, you will need to include single quotation marks (' ') around 

the name. For example, if you wanted to reference cell A1 on a worksheet named July Budget, its cell 

reference would be 'July Budget'!A1. 

To reference cells across worksheets: 

In our example below, we'll refer to a cell with a calculated value between two worksheets. This will allow us 

to use the exact same value on two different worksheets without rewriting the formula or copying data 

between worksheets. 

1. Locate the cell you want to reference, and note its worksheet. In our example, we want to 
reference cell E14 on the Menu Order worksheet. 



 

2. Navigate to the desired worksheet. In our example, we'll select the Catering 
Invoice worksheet. 

 

3. The selected worksheet will appear. 

4. Locate and select the cell where you want the value to appear. In our example, we'll select 
cell B2. 

 

5. Type the equals sign (=), the sheet name followed by an exclamation point (!), and the cell 
address. In our example, we'll type ='Menu Order'!E14. 



 

6. Press Enter on your keyboard. The value of the referenced cell will appear. If the value of cell 
E14 changes on the Menu Order worksheet, it will be updated automatically on the Catering 
Invoice worksheet. 

 

If you rename your worksheet at a later point, the cell reference will be updated automatically to reflect the 

new worksheet name. 

If you enter a worksheet name incorrectly, the #REF! error will appear in the cell. In our example below, we've 

mistyped the name of the worksheet. Click the Error button and select the desired option from the drop-

down menu to edit or ignore the error. 



 

Challenge! 

1. Open the practice document Excel2013_References_Practice.xlsx. 

2. Create a formula that uses a relative reference. Use the fill handle to fill in the formula in 
cells E4 through E14. Double-click a cell to see the copied formula and the relative cell 
references. 

3. Create a formula that uses an absolute reference. Correct the formula in cell D4 to refer only 
to the tax rate in cell E2 as an absolute reference, then use the fill handle to fill the formula 
from cells D4 to D14. 

4. Try referencing a cell across worksheets. Create a cell reference in cell B3 on 
the Catering Invoice worksheet for cell E15 on the Menu Order worksheet. 

Functions 

A function is a predefined formula that performs calculations using specific values in a particular order. Excel 

includes many common functions that can be useful for quickly finding the sum, average, count, maximum 

value, and minimum value for a range of cells. In order to use functions correctly, you'll need to understand 

the different parts of a function and how to create arguments to calculate values and cell references 

Practice document: Excel2013_Functions_Practice.xlsx 

The parts of a function 

In order to work correctly, a function must be written a specific way, which is called the syntax. The basic 

syntax for a function is the equals sign (=), the function name (SUM, for example), and one or 

more arguments. Arguments contain the information you want to calculate. The function in the example 

below would add the values of the cell range A1:A20. 



 

Working with arguments 

Arguments can refer to both individual cells and cell ranges and must be enclosed within parentheses. You 

can include one argument or multiple arguments, depending on the syntax required for the function. 

For example, the function =AVERAGE(B1:B9) would calculate the average of the values in the cell range 

B1:B9. This function contains only one argument. 

 

Multiple arguments must be separated by a comma. For example, the function =SUM(A1:A3, C1:C2, 

E1) will add the values of all the cells in the three arguments. 



 

Creating a function 

Excel has a variety of functions available. Here are some of the most common functions you'll use: 

 SUM: This function adds all of the values of the cells in the argument. 

 AVERAGE: This function determines the average of the values included in the argument. It 
calculates the sum of the cells and then divides that value by the number of cells in the 
argument. 

 COUNT: This function counts the number of cells with numerical data in the argument. This 
function is useful for quickly counting items in a cell range. 

 MAX: This function determines the highest cell value included in the argument. 

 MIN: This function determines the lowest cell value included in the argument. 

To create a basic function: 

In our example below, we'll create a basic function to calculate the average price per unit for a list of recently 

ordered items using the AVERAGE function. 

1. Select the cell that will contain the function. In our example, we'll select cell C11. 

 



2. Type the equals sign (=) and enter the desired function name. You can also select the desired 
function from the list of suggested functions that will appear below the cell as you type. In our 
example, we'll type =AVERAGE. 

 

3. Enter the cell range for the argument inside parentheses. In our example, we'll type (C3:C10). 
This formula will add the values of cells C3:C10 and then divide that value by the total number 
of cells in the range to determine the average. 

 

4. Press Enter on your keyboard. The function will be calculated, and the result will appear in the 
cell. In our example, the average price per unit of items ordered was $15.93. 



 

To create a function using the AutoSum command: 

The AutoSum command allows you to automatically insert the most common functions into your formula, 

including SUM, AVERAGE, COUNT, MIN, and MAX. In our example below, we'll create a function to calculate 

the total cost for a list of recently ordered items using the SUM function. 

1. Select the cell that will contain the function. In our example, we'll select cell D12. 

 

2. In the Editing group on the Home tab, locate and select the arrow next to 
the AutoSum command and then choose the desired function from the drop-down menu. In 
our example, we'll select Sum. 



 

3. The selected function will appear in the cell. If logically placed, the AutoSum command 
will automatically select a cell range for the argument. In our example, cells D3:D11 were 
selected automatically and their values will be added together to calculate the total cost. You 
can also manually enter the desired cell range into the argument. 

 

4. Press Enter on your keyboard. The function will be calculated, and the result will appear in the 
cell. In our example, the sum of D3:D11 is $606.05. 

 



The AutoSum command can also be accessed from the Formulas tab on the Ribbon. 

 

The Function Library 

While there are hundreds of functions in Excel, the ones you use most frequently will depend on the type of 

data your workbooks contains. There is no need to learn every single function, but exploring some of the 

different types of functions will be helpful as you create new projects. You can search for functions by 

category, such as Financial, Logical, Text, Date & Time, and more from the Function Library on 

the Formulas tab. 

 To access the Function Library, select the Formulas tab on the Ribbon. 
The Function Library will appear. 

 

Click the buttons in the interactive below to learn more about the different types of functions in Excel. 



 

To insert a function from the Function Library: 

In our example below, we'll use a function to calculate the number of business days it took to receive items 

after they were ordered. In our example, we'll use the dates in columns B and C to calculate the delivery time 

in column D. 

1. Select the cell that will contain the function. In our example, we'll select cell D3. 

 

2. Click the Formulas tab on the Ribbon to access the Function Library. 



3. From the Function Library group, select the desired function category. In our example, we'll 
choose Date & Time. 

 

4. Select the desired function from the drop-down menu. In our example, we'll select 
the NETWORKDAYS function to count the number of business days between the ordered date 
and received date. 

 

5. The Function Arguments dialog box will appear. From here, you'll be able to enter or select the 
cells that will make up the arguments in the function. In our example, we'll enter B3 in 
the Start_date: field and C3 in the End_date: field. 

6. When you're satisfied with the arguments, click OK. 



 

7. The function will be calculated, and the result will appear in the cell. In our example, the result 
shows that it took four business days to receive the order. 

 

Like formulas, functions can be copied to adjacent cells. Hover the mouse over the cell that contains the 

function, then click, hold, and drag the fill handle over the cells you want to fill. The function will be copied, 

and values for those cells will be calculated relative to their rows or columns. 



 

The Insert Function command 

If you're having trouble finding the right function, the Insert Function command allows you to search for 

functions using keywords. While it can be useful, this command is sometimes difficult to use. If you don't have 

much experience with functions, you may have more success browsing the Function Library instead. For 

more advanced users, however, the Insert Function command can be a powerful way to find a function 

quickly. 

To use the Insert Function command: 

In our example below, we want to find a function that will count the total number of items ordered. We want 

to count the cells in the Item column, which uses text. We cannot use the basic COUNT function because it 

will only count cells with numerical information. Instead, we will need to find a function that counts the total 

number of cells within a cell range. 

1. Select the cell that will contain the function. In our example, we'll select cell B16. 



 

2. Click the Formulas tab on the Ribbon, then select the Insert Function command. 

 

3. The Insert Function dialog box will appear. 

4. Type a few keywords describing the calculation you want the function to perform, then 
click Go. In our example, we'll type Count cells, but you can also search by selecting 
a category from the drop-down list. 



 

5. Review the results to find the desired function, then click OK. In our example, we'll 
choose COUNTA because it will count the number of cells in a cell range. 

 

6. The Function Arguments dialog box will appear. Select the Value1: field, then enter or select 
the desired cells. In our example, we'll enter the cell range A3:A10. You may continue to add 
arguments in the Value2: field, but in this case we only want to count the number of cells in 
the cell range A3:A10. 

7. When you're satisfied, click OK. 



 

8. The function will be calculated, and the result will appear in the cell. In our example, the result 
shows that a total of eight items were ordered. 

 

Challenge! 

1. Open the practice document Excel2013_Functions_Practice.xlsx. 

2. Create a function that contains one argument. Use the SUM function in cell B16 to calculate 
the total quantity of items ordered. 

3. Use the AutoSum command to insert a function. Insert the MAX function in cell B23 and use 
the cell range D3:D15for the argument to find the most expensive item that was ordered. 



4. Explore the Function Library, and try using the Insert Function command to search for 
different types of functions. 

Homework 

1. Linear Regression 

Fill out the following data in a spreadsheet: 

 A B C D E F G 

1 AGE X GLUCOSE LEVEL Y x y xy x2 y2 

2 43 99      

3 21 65      

4 25 79      

5 42 75      

6 57 87      

7 59 81      

8 
  

     
 

To calculate the linear regression 𝑦 = 𝑎 + 𝑏𝑥 that approximates a set of data points you will need to: 

1. Find the average of X’s and Y’s 

Insert the formula =AVERAGE(A2:A7) in cell A8. 

Insert the formula =AVERAGE(B2:B7) in cell B8. 

 

2. Compute the standard deviation about X and Y: 

𝑥 = 𝑋 − 𝑋𝑎𝑣𝑔, 𝑦 = 𝑌 − 𝑌𝑎𝑣𝑔 

Insert the formula =A2-$A$8 in cell C2 and copy the formula down with the fill handle. 

Do the same for the y column 

 

3. Compute the squared values of the standard deviations and the scalar product of x and y 

Insert the formula =C2*D2 in cell E2 and copy the formula down with the fill handle. 

Insert the formula =C2*C2 in cell F2 and copy the formula down with the fill handle. 

Do the same for the y2 column. 

 

4. Compute the coefficients of the line a and b: 

𝑏 =
∑ 𝑥𝑦

∑ 𝑥2
 𝑎𝑛𝑑 𝑎 = 𝑌𝑎𝑣𝑔 − 𝑏𝑋𝑎𝑣𝑔 

Add the function =SUM(E2:E7) in cell E8. 

Do the same for the remaining two columns x2 and y2 

Compute in two adjacent cell the two coefficients a and b: 

a = 65.14157 and b = 0.385225 

In the end, the table should have the following values: 

 

 



AGE X GLUCOSE LEVEL Y x y xy x2 y2 Ycomp 

43 99 1.833333 18 33 3.361111 324 81.70625 

21 65 -20.1667 -16 322.6667 406.6944 256 73.2313 

25 79 -16.1667 -2 32.33333 261.3611 4 74.7722 

42 75 0.833333 -6 -5 0.694444 36 81.32102 

57 87 15.83333 6 95 250.6944 36 87.0994 

59 81 17.83333 0 0 318.0278 0 87.86985 

41.16667 81 
  

478 1240.833 656 
 

        

    
b 0.385225 

  

    
a 65.14157 

  

 

2. Centroid cross section 

To calculate the centroid of a cross section made out of parts with known centroid positions about a central 

coordinate system, the following formulae can be used: 

𝑥 =
∑ 𝑥𝑖𝐴𝑖

𝑛
𝑖=1

∑ 𝐴𝑖
𝑛
𝑖=1

, 𝑦 =
∑ 𝑦𝑖𝐴𝑖

𝑛
𝑖=1

∑ 𝐴𝑖
𝑛
𝑖=1

 

where: xi and yi are the coordinates of each parts centroid about the global axis and Ai is the area of the part 

 

1. Create a new spreadsheet 

2. Fill out the header of the table as in the figure below. 

3. Fill out each parts area, and centroid position x and y 

4. Enter the formulas for calculating the products between each area and their coordinates in columns E 

and F. 

5. Sum up the values in columns E and F 

6. Compute the centroids position with the two formulae given in the beginning 

 

1 

2 

3 

1 1 3 

2
 

1
 

1
 



 A B C D E F 

1 Part Ai xi yi xiAi yiAi 

2 1 4 0.5 2   

3 2 
 

    

4 3 
 

    

5  
 

 Σ   

6 
  

    
 

 

 

 

 

 

 

 


